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Section 1: Introduction 
 
 
The purpose of this manual is to assist in the installation and operation of the Venus� 1500 Display 
Network. Refer to Appendix A for the system riser diagram for a multiple display hookup. 
 
 
1.1 System Requirements 
 
The Venus 1500 operating software has the following requirements: 
 

�� Personal computer running Windows� 98, Me�, NT� 4.0, 2000 or XP Home/Professional 
with the most current updates installed. 

�� Personal computer using a Pentium� 233 class or higher microprocessor (Pentium II 400 
recommended) 

�� 32MB RAM (64MB RAM recommended) 
�� CDROM Drive 
�� Mouse or other pointing device 
�� One or more Venus 1500-compatible displays installed 
�� 12MB hard disk space (Additional space may be required for message and schedule storage) 

 
 
1.2 Using the Mouse 
 
The following terms are used to describe various mouse actions: 
 

�� CLICK means quickly press and release the primary mouse button. 
 

�� DOUBLE-CLICK means quickly press and release the primary mouse button twice. 
 

�� HIGHLIGHT means to click the mouse button over text. The text will have a colored bar 
placed over it. 

 
�� SELECT means to click the mouse button over text. The text will be marked, such as by a 

check mark �, in a nearby box. 
 
 
1.3 Using the Keyboard 
 
Many of the options in the Venus 1500 software can be accessed with the keyboard. Where applicable, 
both mouse and keyboard actions will be given to accomplish a command. Many screen buttons have 
labels which have a letter underlined. Pressing the <ALT> key on the keyboard and then typing the 
underlined letter will activate that particular button. 
 
An uppercase word in brackets (such as [OK]) represents a button on the screen. The names or letters 
of keys on the keyboard will be given enclosed in arrows (such as <ENTER>) to differentiate between 
the screen commands. For two or more key combinations, such as <ALT><E>, <CTRL><HOME> or 
<CTRL><SHIFT><SPACE>, hold down the first key (and second key, if applicable) as the last key is 
pressed. 
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1.4 Definitions 
 
The following are terms and definitions used throughout the manual and software. 
 
Apply: Clicking [APPLY] on some screens allows changes to take effect without closing the box; an 
alternative to [OK]. 
 
Attributes: Attributes are various characteristics and options applied to frames and text. Attributes 
can include color, justification and flashing text, as well as various entry and exit effects.  
 
Baud Rate: Baud Rate refers the speed of serial communications.  
 
Cancel: Clicking on [CANCEL] cancels the last command and closes the window. This icon can also 
be activated by pressing <ESC> on the keyboard. 
 
Com Port: The Com Port is the serial port in the PC that is used to communicate with the display. 
The ports shown are installed in the operating system.  
 
Configure: Configure refers to programming the size and display type of a display or specifying 
parameters for a network or group of displays within the software. 
 
DataTrac�: Daktronics family of text-only (alphanumeric) LED displays; they are offered as single-
sided units and show 5x7, single stroke character fonts. 
 
Dial Up: Dial up refers to the type of communication the main controller has with a display. Dial up 
indicates that a dialing modem is required to communicate with the display. 
 
Direct: Direct refers to the type of communication the main controller has with a display. Direct 
indicates a dedicated wire connection between the PC and display(s).  
 
Display Address: Display address is a number in the range of 1 through 240 that identifies an 
individual display. Each display on a network must have a unique address. 
 
Display Type: Display type refers to the type of display (DataTrac, InfoNet, Galaxy, SunSpot or 
Glow Cube), display color (monochrome, tricolor or RGB), number of lines and characters per line. 
Messages and schedules are based on display type�not the individual display. Knowing the display’s 
type is required for configuring the software.  
 
Effect: An effect is a “moving” characteristic applied to line of text or graphic frame to create interest 
and variety in a message.  
 
Ethernet: A local area network (LAN) protocol using a bus topology.  
 
Event: Event refers to a message displayed within a schedule or a scheduled brightness change. 
 
Frame: A frame is a “page” of text on the display. Text and/or characters are typed onto the frame to 
create messages. A message can be composed of one frame or multiple frames. 
 
Galaxy�: Daktronics trademarked name for matrix-based LED (light emitting diode) displays; 
technologies are available for monochrome red or amber, tricolor (red, green and amber) or RGB (red, 
green and blue). 
 
Glow Cube�: Daktronics product line of reflective, electro-mechanical display technology; consists of 
cube-shaped pixels with faces that rotate 180 degrees to show either a yellow or black side. 
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Group: A group is a collection of displays of the same display type. The group may be selected 
instead of the individual displays. When displays belong to a group, the displays will have the ability 
to receive the same commands when the group is selected. For example, if a group of cafeteria 
displays are to have the same message, a group called CAFETERIA could be created. Groups are time 
saving. 
 
Hold: Hold refers to the length of time a frame will remain on the display once all the entry effects 
have been completed.  
 
InfoNet�: Daktronics product line of line-based monochrome LED (light emitting diode) displays. 
 
ITF File: ITF files consist of multiple RTD fields that are generated by the source program to simplify 
the creation of data frames. 
 
Library: A Library is a group of messages or schedules of similar type. For example, a series of 
Christmas messages could be saved in a library called CHRISTMS. Libraries are stored based on 
display type. 
 
Monochrome: Monochrome displays are capable of displaying only one color. 
 
Network: A network consists of multiple displays connected to each other. Up to 240 Venus 1500 
controlled displays can exist on one network. 
 
OK: Clicking on [OK] executes a command and/or closes the window. This icon can sometimes be 
activated by pressing <ENTER> on the keyboard. 
 
RG: RG, or tricolor, displays are capable of showing red, green and amber colors. Red and green 
LEDs combine to create the amber color. 
 
RGB: RGB (red, green, blue) refers to the colors of LEDs used on this type of display. These colors 
combine to create a full-color display. 
 
RTD: Real Time Data; RTD fields allow information from an outside source (such as a timer or 
counter) to be inserted into a message. 
 
Schedule: A schedule is similar to an appointment book for a display. It allows the user to tell a 
display what message to display when and sets the brightness of the display. These instructions can be 
set on a day to day, hour to hour or minute to minute basis. For example, a display can be told to start 
a message called BIGSALE at 1:33pm on 1/3, and at the same time set the brightness level at 32 
(50%). Refer to Section 6: for more information. 
 
Shell: When the Venus 1500 software program starts, a shell program loads. Each component of the 
software (Message Studio, Schedule Studio, etc.) is launched from this program. Refer to Section 1.6 
for an illustration of the shell. 
 
Status: When communicating with a display, sometimes it is helpful to know the status of the display. 
Status refers to the display’s name and version number, the date and time running on the display, last 
reset time, temperature, display brightness and running messages.  
 
SunSpot�: Daktronics registered trademark name for matrix-based, monochrome, incandescent 
(lamp) displays. 
 
TCP/IP: Abbreviation for Transmission Control Protocol/Internet Protocol; the suite of 
communications protocols used to connect hosts on the Internet or Local Area Network (LAN). 
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TCP/IP Connection Type: Display connection across an Ethernet network using the TCP/IP 
protocol. This type of connection requires a serial server device connected to an Ethernet network for 
communication to displays. 
 
TCP/IP Socket: Software communication component within the TCP/IP protocol used for sending 
and receiving data across the network. 
 
Tricolor: RG, or tricolor, displays are capable of showing red, green and amber colors. Red and green 
LEDs combine to create the amber color. 
 
Venus�: Daktronics registered trademark name for a family of message/animation display control 
software systems. The higher the Venus controller model number, the larger the matrix it can control. 
 
 
1.5 Help 
 
Help is available from the Help pull-down menu. Two 
options will appear: Contents and About.  
 

Contents 
Press <ALT><C> or click on [CONTENTS] to access 
the Contents help screen. This screen can also be 
accessed directly from the main screen by pressing 
<F1>. 

 
 

About 
Each area of the software (Message Studio, 
Schedule Studio, etc.) contains a Venus 1500 
About dialog box that can be accessed from the 
Help pull-down menu. The Venus 1500 About box 
contains information about the software, including 
the software version, and Daktronics’ contact 
information. Click on [OK] or press <ENTER> to 
exit the Venus 1500 About box. 

 
 
1.6 Navigating the Venus 1500 Software 
 
When the Venus 1500 software program starts, a “shell” program loads. Each component of the 
software (Message Studio, Schedule Studio, etc.) is launched from this program. Click on the 
appropriate shell button to activate the desired component. 

 
Venus 1500 Shell Program 

 
Messages and schedules are saved as files within the Venus 1500 software. The files are stored within 
directories known as “libraries.” Libraries are created for each type of display.  
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When creating a new or opening an existing message/schedule, a small box will be visible to the left 
of each display type. When the box is filled with a “+”, libraries exist for that type that are not 
currently visible.  
 

1. Click on the “+” or double-click on the display type name to expand the directory and view 
that type’s libraries. The “+” will change to a “�”.  

2. Click on the name of the desired library to access the list of messages or schedules located 
within it. 

 
�Note: The Venus 1500 Shell program defaults to “Always on Top,” placing it on top of any other 
programs that may be displayed on the desktop. To turn this feature off:  
 

1. Right-click on the shell’s Venus 1500 logo. A popup menu appears. Always on Top should 
have a check mark next to it. 

2. Click on Always on Top to remove the check mark. 
 
 
1.7 Basic Steps to Using the Venus 1500 Controller Software 
 
This manual is laid out in basic chronological order to create and display a message. In summary, the 
steps you will need to follow are: 
 

1. Install the Venus 1500 controller software if it is not already installed on your computer 
(Section 2). 

2. Configure the display type(s) and communication method (Sections 3 and 4). 
3. Create the message(s) (Section 5). 
4. Create the schedule(s), when desired (Section 6). 
5. Send the message/schedule to the display (Section 7). 
6. Run the message/schedule (Section 7). 

 
This book will walk you through the steps necessary to help you use your display system to its full 
potential. 
 
 
1.8 Contacting Daktronics 
 
If any problems or questions arise that are not discussed in this manual, contact Daktronics using any 
of the following methods: 
 
Mail: Daktronics, Inc., Customer Service  Customer Service Fax: 1-605 / 697-4444 

PO Box 5128 
331 32nd Avenue    e-mail: helpdesk@daktronics.com 
Brookings, SD 57006 

 
Phone: Daktronics Help Desk: 1-877 / 605-1112 (toll free)  

or 1-605 / 697-4033 
 
Keyframe� Software Support: 1-877 / 605-1118 (toll free)  
or 1-605 / 697-4003 
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Section 2: Installation 

 
 
The Venus 1500 software must be installed to a hard disk before use. To install the software onto a 
computer, follow these steps: 
 

1. Place the Venus 1500 installation compact disk (CD) into the appropriate CD ROM (presume 
drive D:). 

 
2. The installation should begin automatically within a few seconds. If it does not, click on the 

Start button and select Run from the menu. Type “D:\SETUP” and press <ENTER>. 
 
3. Follow the instructions on the screen. SETUP will copy the files necessary to run the Venus 

1500 software to the hard disk and create Venus 1500 in the Start menu. Note: The Venus 
1500 software installs to the C:\Program Files\Daktronics\Venus 1500 directory by default; 
this is the recommended location. 

 
4. The Venus 1500 control software is now installed and ready to be configured for use with the 

Venus 1500 Display Network. 
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Section 3: Configuring the Venus 1500 
Controller for First Time Use 

 
 
�This section is intended to provide basic instructions and examples to configure the Venus 1500 
Controller. More detailed information and instructions on installing other network and display types 
can be found in Section 4. 
 
After installing the Venus 1500 Controller software on the computer (refer to Section 2), the 
individual displays and networks must be configured. The three basic steps to configure the software 
consist of the following: 
 

1. Adding a network 
2. Adding the display type 
3. Adding the display 

 
Once these steps are complete, you can proceed to Section 5 to create messages for the display. 

The Venus 1500 Administrator is used to configure networks and displays. Click on  from 
the Venus 1500 Shell to start the Administrator. 
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3.1 Adding a Direct Connection Network 
 
The simplest type of network to use is a “direct” network. On this type of network, a dedicated wire 
connection is used between the control computer and display(s). (No modem is used.) 
 

1. Click on  at the top of the Venus 1500 Administrator to activate the network 
configuration screen.  

2. Right-click on 
Direct Networks 
on the left side of 
the screen. A 
popup menu 
appears. Click on 
New… 
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3. In the 
Description 
(name) field, 
enter a name for 
the new network.  

4. Select Direct 
Networks in the 
Network Type field, if it is not 
already selected. 

5. Click once on the down arrow next 
to COM ports. A listing of 
installed ports for your computer 
appears. 

6. Select the desired serial port for 
display communications. (The 
default is COM1.) 

7. Click on [OK] to save the changes 
and close the Network 
Configuration dialog box. 

 
 
3.2 Adding the Display Type 
 
The display type refers to the basic description of the display and the technology (line, character or 
matrix display, LED, reflective or incandescent, color depth, etc.). In this section, we will assume a 
tricolor (red, green and amber) LED matrix sign will be used (a Daktronics Galaxy display). The 
display is 64 pixels high by 120 pixels wide. 

1. Click on  
to activate the display 
configuration screen.  

2. From the Edit pull-down 
menu, select New and then 
Display Type. The Display 
Type Configuration dialog 
box appears.  

3. Click on the down arrow 
next to the Technology 
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box. Select Galaxy (LED). The fields in the lower half of the dialog box will adjust based on 
the selected type of technology.  

4. Use the drop-down menus to select “64” for the Height, “120” for the Width and “Tricolor” 
for the Color Depth. Only valid sizes and colors for the current display technology will be 
available for selection. 

5. Click on [OK] to save the settings.  
 
 
3.3 Adding a Display 

 
We will assume a Galaxy display of the type setup in Section 3.2 will be added in front of the office 
building. The address of the sign (as shown in the display’s boot up initialization information [refer to 
the display’s maintenance and troubleshooting manual]) is eight (8). The sign will be placed on the 
network configured in Section 3.1. 
 

Configuring the Venus 1500 3-3

1. Be sure the Display 
Configuration button is 
selected in the Venus 
1500 Administrator. 

2. From the Edit pull-down 
menu, select New and 
then Display, The 
Display Configuration 
dialog box appears. 

3. Enter a Description for 
the display. It can be a number or a brief description of its location. In the example, the sign 
was named “Outdoor Entrance.” 

4. Enter “8” for the display’s network Address.  
5. From the drop-down menu for Display Type, select “Galaxy 64x120 Tricolor.” 
6. Select the Direct network configured in Section 3.1. 
7. Click on [OK] to save the new display configuration. 

 
 
3.4 Proceeding to Create a Message 
 
Once the steps outlined in Sections 3.1, 3.2 and 3.3 are complete, close the Venus 1500 Administrator 
by selecting Exit from the File pull-down menu. 
 

Return to the Venus 1500 Shell program and click on  to activate the Venus 1500 Message 
Studio to create a message (refer to Section 5). 
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Section 4: The Venus 1500 Administrator 
 
 
The Venus 1500 Administrator is used to configure the various displays, display types, display groups 
and networks, or test the network. 

To activate the Venus 1500 Administrator, click on from the Venus 1500 Shell. 

 
The screen is divided into two basic areas. At the left are all the currently configured display types 
(when Display Configuration is selected) or networks (when Network Configuration is used). The 
right side of the screen displays the configuration details for the currently selected display or network. 
 

Activating  configures a network for communicating with displays. The Network 
Configuration screen allows the user to add a network, edit an existing network or remove a network. 
 

Selecting  enables the user to add and/or delete display types, or edit displays and 
groups for display types. 
 
The number of display types that can be configured in the system is virtually unlimited. 
 
 

The Venus 1500 Administrator 4-1
 



4.1 Adding a Network 
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Click on 

 to 
activate the network 
configuration screen.  
 
Right-click on any of the 
network names listed on 
the left side of the 
screen. A popup menu 
appears. Click on 
New… 
 
Or activate the Edit pull-
down menu and select 
New and then Network.  
 

 
There are three connection types that can be used for a display: direct, dialup and TCP/IP. Whenever a 
new network is configured, you must give it a name (entered in the Description (name): field). 
 
 

Direct Connection 
A direct connection indicates a line of communication directly from the operator’s computer to the 
display or network. 
 

1. To use this type of 
connection, select Direct 
Networks in the Network 
Type field, if it is not already 
selected. 

2. Click once on the down 
arrow next to COM ports. A 
listing of installed ports for 
your computer appear. 

3. Select the desired serial port 
for display communications. 
(The default is COM1.) 

4. Click on [OK] to save the 
changes and close the Network Configuration dialog box. 

 
 

Dialup Connection 
A dialup connection uses a modem to communicate with the display or network. It is assumed a 
modem is already installed and operating properly prior to selecting a dialup connection type. For 
more information regarding modem installation, consult the manual accompanying the modem or 
contact the modem’s manufacturer. 
 
If you are having modem communications problems, ensure that the most recent modem drivers 
for your operating system are installed and are properly configured. 

 

 



1. To use this type of connection, select Dialup Networks in the Network Type field, if it is 
not already selected. 

2. Click on the down arrow 
next to Modem. A list of 
currently installed modems 
appears. Select the modem 
you wish to use. 

3. Press <TAB> or use the 
mouse to click once in the 
Phone Number field. Enter 
the phone number of the 
display. The use of commas 
and dashes between numbers 
are permissible but not 
necessary. 

4. Click on [OK] to save the new network and close the Network Configuration dialog box. 
 
 

TCP/IP Connection 
A TCP/IP network uses an Ethernet� network and a serial server device to establish a connection 
between the Venus 1500 controller and the displays. 

 
The TCP/IP Address is the address of 
the serial server device on the Ethernet 
Network. If you are using a Lantronix� 
serial server, this is the address that was 
set on the device when it was configured. 
Refer to Daktronics manual ED-9623 for 
instructions on configuring the serial 
server and assigning a static IP address. 
 
 
 
 

�Note: This address must match and be configured on both the Venus 1500 software and the 
serial server. 
 
Use Default should always be checked � when using the Lantronix serial server. 
 
The Socket number is only accessible when Use Default is not checked. This field is used to 
interface to another serial server device. For information on the socket number, refer to the serial 
server’s operation manual to find which socket is used for raw data or RS-232 communication. 
 
�Note: TCP/IP must be installed and correctly configured for the computer the Venus 1500 
software is installed on. The TCP/IP protocol must also be bound to the Ethernet packet/ODI 
driver. DHCP is not used. The address of the serial server must be static. Contact your system 
administrator to obtain a static IP address and to configure the computer as needed for the display 
network. 
 

1. To use this type of connection, click on TCP/IP Networks in the Network Type field, if 
it is not already selected. 

2. Use the mouse to click once in the TCP/IP Address box. 
3. Enter the correct address for the network. 

The Venus 1500 Administrator 4-3
 



4. If a Lantronix serial server is being used, click on Use Default. Otherwise, enter the 
socket number in the corresponding box. 

5. Click on [OK] to save the new network and close the Network Configuration dialog box. 
 
 

4.2 Editing an Existing Network 
 
To modify the settings of an existing network, either right-click on a network name at the left side of 
the screen, and then click on Edit… on the popup menu, or activate the Edit pull-down menu and 
select Edit, and then Network. The Network Configuration dialog box appears. Edit the information 
as needed. 
 
 
4.3 Deleting a Network 
 
To remove a network, right-click on a network 
name at the left side of the screen, and then 
click on Delete on the popup menu. A dialog 
box appears requesting a confirmation of the 
deletion. 
 
Click on [OK] to delete the network or 
[CANCEL] to leave the network intact. 
 
�Note: Performing this action can leave 
displays unusable. 
 
 
 
 
 
 
4.4 Remote Database 
 
For locations that have multiple computers with Venus 1500 capability a remote database can be 
configured for storing messages. This allows messages to be shared between machines without 
needing to copy them from one machine to another. 

1. Select Venus 1500 Administrator from the Venus 1500 shell 
2. Click on the [Edit] drop down menu and select Database. 
3. Select the Remote Database location by clicking on the browse button. 
4. Browse to the new database location and click OK to select it. 
5. Click on OK to close the Remote Database dialog. You will be prompted to move the contents 

of the local database to the remote location. 
 
Note: This is simply a sharing function and does not synchronize computers or displays in any 

way. Any existing messages with the same names will be overwritten. It is best to perform 
this configuration immediately before configuring your displays and messages are 
created. 
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4.5 Communication Defaults (Networks) 
 
The operator can specify default settings for timeouts, 
maximum retries and disconnect time for each of the 
network types. 
 
From the Edit pull-down menu, select Defaults. The 
Communication Defaults dialog box appears. 
 
Change the settings as desired using the arrows next to 
each field, or by highlighting the number and entering 
the new value from the keyboard. 
 
Click on [APPLY] to save the settings but keep the 
Communication Defaults dialog box open. Click on 
[OK] to save the settings and close the dialog box. 
[CANCEL] will abort all changes and exit the dialog 
box. 
 
The minimum value for all fields is 1. The maximum 
values for each field are as follows: 
 
 

Communication Timeouts Maximum Retries Disconnect Time 
Direct: 60 Sec Direct: 10 Direct: 90 Sec 
Dialup: 30 Sec Dialup: 10 Dialup: 30 Min 
TCP/IP: 30 Sec TCP/IP: 10 TCP/IP: 90 Sec 

 
 
4.6 Display Type 
 
 

Adding a New Type of Display 
�Note: Confirm your display size, technology and color before configuring the Venus 1500 
controller. Incorrect configuration settings may cause unwanted display results. 

 

Click on  to 
activate the display 
configuration screen.  
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1. From the Edit pull-

down menu, select New 
and then Display Type. 
The Display Type 
Configuration dialog 
box appears.  

2. Click on the down 
arrow next to the 
Technology box. Select 
the technology for your display (DataTrac, InfoNet, Galaxy, SunSpot or Glow Cube).  

3. The fields in the lower half of the dialog box will adjust based on the type of technology 
selected. Use the drop-down menus to select the correct display size and color. Only valid 

 



sizes and colors for the current display technology will be available for selection. 
 

If the display is a DataTrac, enter the color (monochrome or tri-color), number of lines in 
the display and the number of characters per line; if the display is an InfoNet, enter the 
color, line height and width and total number of lines in the display. 
 
The matrix displays, Galaxy, SunSpot and Glow Cube, require the number of pixels high 
and wide be entered. Galaxy displays may be configured as monochrome, tri-color or 
RGB (red, green, blue). SunSpot and Glow Cube displays are available only as 
monochrome. 

 
The Description field will reflect the current settings and lists how the display type will 
be presented in the Venus 1500 software. 
 

4. Once the configuration is complete, click on [OK] to save the settings. [CANCEL] will 
discard all changes and return you to the Venus 1500 Administrator. 

 
�Note: Once a display type has been created, add other types by highlighting the existing display 
type and then right-clicking the mouse to activate the popup menu. Select New and then Display 
Type. The Display Type Configuration dialog box appears. By default, the technology listed will 
initially match that of the existing display type. Setup the new display type as desired per the 

above instructions. 
Removing a Display Type 
To remove a display type, highlight the type in 
the left side of the Venus 1500 Administrator. 
Right-click to active the popup menu and 
select Delete. A dialog box appears requesting 
a confirmation of the deletion. 
 
Click on [OK] to delete the display type or 
[CANCEL] to leave the type intact. 
 
�Note: Performing this action can leave 
displays unusable. 
 
 
 
 

 
 
4.7 Displays 
 
Once display types and networks are configured, you can begin configuring the individual displays. 
 
 

Adding a Display 
To add a display to the software, first be sure the Display Configuration button is selected in the 
Venus 1500 Administrator. 
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1. From the Edit 
pull-down menu, 
select New and 
then Display, or 
right-click on a 
display type or 
another existing 
display name and 
select New and 
then Display. The 
Display 
Configuration dialog box appears. 

2. Enter a description for the display. It can be a number or a brief description of its location. 
3. Enter the display’s network address. (The address of the display appears as part of the 

boot up initialization information. Refer to the display’s maintenance and troubleshooting 
manual for more information.) 

4. Specify the display type. Lists of currently configured display types are available from the 
drop-down menu. 

5. Select the appropriate network on which the display is located. 
6. Click on [OK] to save the new display configuration. 

 
�Note: A display cannot be programmed if a network is not configured. 
 
 
Creating a Group of Displays 
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A group is a collection of displays of 
the same display type that can receive 
various communications commands 
simultaneously. A group is not 
required for display communications. 
 
�Note: Display types must be 
configured and displays added before 
this option can be used. 
 

1. To create a new group, select 
New and then Display Group 
from the Edit pull-down 
menu. The Display Group 
Configuration dialog box 
appears. 

2. Enter a name for the group. 
3. Select the group’s display 

type. A list of available displays appears in the left half of the dialog box. 
4. Highlight the display(s) you wish to be included in the group and click on [ADD>>]. The 

display(s) are added to the Member Displays list. (To pick more than one display at a 
time, press and hold <SHIFT> while using the mouse to select a range of displays, or press 
and hold <CTRL> to pick out individual displays.) 

 
Remove a display by highlighting its name under Member Displays and click on 
[<<REMOVE]. 

 
5. Click on [OK] to save the display group or choose [CANCEL] to discard all settings and 

exit the dialog box. 



Editing a Display’s Configuration 
To modify the settings of an existing display or display group, either right-click on a display or 
group name at the left side of the screen, and then click on Edit… on the popup menu, or activate 
the Edit pull-down menu and select Edit, and then Display (to edit a single display) or Display 
Group (to modify a group). The appropriate configuration dialog box appears. Edit the 
information as needed. 

 
 

Deleting a Display from the Network 
To remove a display or group, right-click on the name at the left side of the screen, and then click 
on Delete on the popup menu. A dialog box appears requesting a confirmation of the deletion. 
 
Click on [OK] to delete the display or group or [CANCEL] to leave it. 
 
 

4.8 Enabling the Text Filter (Profanity Protection) 
 

The Venus 1500 software’s text filter 
prevents specified words from 
appearing on the display(s).  
 
To enable or modify this filter, activate 
the Venus 1500 Administrator Edit 
pull-down menu, and select Message 
Text Filter.  
 
Two filters can be enabled, the Default 
Filter and the Custom Filter.  
 
The default profanity filter protects 
against words identified in the FCC vs. 
Pacifica Foundation (438 U.S. 726 
[1978]) legal case. The custom filter 
protects against words identified by the 
operator. 

 
To enable protection against words in either filter, click on the box next to the desired filter. A check 
mark indicates the filter is turned ON.  

 
 

Adding New Words 
To add new words to the custom filter feature, type the new word in the box titled Add New 
Entry. Click on [ADD]. The word is added to the box below. 

 
 

Removing a Word 
To remove a word from the list, highlight the desired word and then click on [REMOVE]. It is 
immediately deleted. 
 

 
Click on [CLOSE] to return to the Venus 1500 Administrator. 
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4.9 Time Zone Offset Configuration 
 
This allows the time that is sent from the controlling PC to be offset according to Greenwich Mean 
Time (GMT) if the display is in a different time zone. This should be set to the current time zone that 
the display being controlled is located in. 
 
 
4.10 Network Testing 
 
Network testing requires the use of a loopback box or adapter. This box/adapter connects the serial 
port transmit and receive pins to determine if the serial port is working and there are no physical 
breaks in the communication cable. It will not determine signal polarity. So it is possible for the 
loopback test to work and still not receive communication resulting from improper wiring. 

1. In the Venus 1500 Administrator, choose .  
2. Right-click on the desired network to activate the pop-up menu and then select Test… The 

Network Testing dialog box appears. 
3. Click [TEST] after attaching the loopback box/adapter to begin testing the network. In the 

Received area of the dialog box, the following results may be returned: 
a. “No response” – indicates a break in the cable, bad serial port or bad signal converter 

(if used.) 
b. “Connection failure” – indicates the test was unable to connect to the serial server if 

connecting to the display via a TCP/IP connection. 
c. The test was successful if the same text appears in both the Sent area and in the 

Received area.  
4. When the test is complete, select [CLOSE] to return to the Venus 1500 Administrator. 

 
 
4.11 Venus 1500 Administrator Keyboard Shortcuts 
 

Command Shortcut Keys
Activate Display Control <F3> 
Activate Network Control <F4> 
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Section 5: The Venus 1500 Message Studio 
 
 
The Venus 1500 Message Studio creates the messages that will appear on the displays. Text and 
graphics are entered into “frames.” One or more frames create a message. When working in the Venus 
1500 Message Studio, thumbnails of existing frames for the current message are displayed along the 
right side of the screen. 

To activate the Venus 1500 Message Studio, click on  at the Venus 1500 Shell. 
 

 
Venus 1500 Message Studio 

Current Frame No. / 
Total No. Frames 

s

There are five basic types of Venus 1500-controlled displays, listed below. 
 

�� Galaxy (LED technology) 
�� DataTrac (LED technology) 
�� InfoNet (LED technology) 
�� SunSpot (Incandescent) 
�� Glow Cube (Reflective) 

 
Different options will be available in the Venus 1500 Message Studio based on the type of display
which the message is being created. Variances will be addressed where applicable in this section. 
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5.1 Opening an Existing Message 
 
To open an existing 
message,  
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1. Click on the 

open button 

 or select 
Open from the 
File pull-down 
menu. The 
Open Message 
dialog box 
appears.  

2. Select the 
desired display 
type and 
library. A list 
of messages 
contained within that library appears in the right side of the screen.  

3. Double-click on the name of the message, or highlight the name and then click on [OPEN]. 
The message is loaded into the Message Studio for editing. 

 
Multiple messages and messages for more than one display type and size can be open for editing at the 
same time. 
 
 
5.2 Creating a New Message 

 

 

To start a new message: 

1. Click on the new button  or select New from the File 
pull-down menu. The New Message dialog box appears. 

2. Double-click on the name of the display for which the new 
message is being created, or click once on the name of the 
display and then click on [OK].  

 
A new, blank text frame configured for the selected display size is 
placed in the Message Studio. Refer to the following subsections 
to add text, graphics and data fields. 
 
The new message will be named when it is saved. Refer to Section 
5.16. 
 
 

 
 

 



Undo/Redo In Message Studio 
 

This tool can be used during the creation of a message to quickly undo an action up to the last ten 
steps. The Redo command can be used to reapply a step that was taken up to ten steps ago. 
 
To undo an action: 

Click on the  button or go to the Edit pull down menu and select Undo. 
 
To redo an action: 

Click on the  button or go to the Edit  pull down menu and select Redo. 
 
 
5.3 Importing an Existing Message from Venus 1500 Version 1 Software 
 
If you have upgraded from Version 1 to Version 2 of the Venus 1500 software, you may have 
messages that were created in Version 1 that you wish to use in the new version. These messages will 
need to be imported into the updated software. 
 

1. Select Import from the File pull-down menu. The Venus 1500 Message File Import Utility 
dialog box appears. 

2. Click on  next to the Input File Path. The Open dialog box appears. 
3. Navigate to the location on your computer or network where the Version 1 messages are 

stored. 
4. Select the desired file and then 

click on [OPEN]. The file’s name 
will be added in the Input File 
Path. 

5. Repeat steps 2 through 4 for the 
Output File Path, except 
navigate to the location where the 
message should be stored as 
Version 2. 

6. Click on [IMPORT]. The message 
will be converted to Version 2 and 
placed in the specified direc
Click on [CLOS

tory. 
7. E] to exit the 

 

.4 Frames 

Message File Import Utility dialog box and return to the Venus 1500 Message Studio. 

 
5
 
A
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 frame is a “page” of text or graphics on the display. Text and/or graphics are entered onto the frame 

 the Venus 1500 software, there are two types of frames, text frames and graphic frames. 
on buttons 

raphic Frames are used to incorporate drawn images into the message. By using a grid, not visible 
on text frames, a combination of both text and graphics may be entered. Only Galaxy, SunSpot or 
Glow Cube displays can use graphic frames. 

to create messages. A message can be composed of one frame or multiple frames.  
 
In
Text Frames are used to display text using various fonts. The operator can use the justificati
to center the text or align it to the left or right. Whenever a new message is created, the first new frame 
is a text frame. 
 
G
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 Message 
On the toolbar above the Message Studio editing 
area, four buttons are used to add and delete frames. 

es t

Delete Frame” will remove the current frame from the message. 
 
 

The lower right corner of the frame 
editing area lists the current frame 

r of 

 

To move from one frame to the next, click on the 
appropriate button. “First Frame” will move to 
Frame 1 of the message. “Last Frame” will move to 

Alternately, you can jump directly to a specifi
of the screen. 
 

ion 
he length of time a frame remains on the display, once all of the entry effects have been 
ompleted, is set in the Frame Duration (Sec) box. Increasing the number will hold the frame 

sing the number will cause the message to move to the next frame at a faster 

oing to the next frame. 

�� When copied, the new frame’s duration is the same as the original frame. 
 the 

messages cannot be less than 0.5 seconds. Lower frame durations 

 
 
Clear F

o remove all text and graphics from a frame, select Clear from the Frame pull-down menu. 

 
 

Adding & Removing Frames from a

he copy immediately after it.  

 
If either a new graphic frame or new text frame is 
added, the frame is placed at the end of the message. 
 
“Insert Copy” duplicates the current frame and plac
 
“

Moving Between Frames 

number out of the total numbe
frames that are in the message 
(represented as a fraction, shown at
right). 
 

the final frame.  
 
c frame by clicking on its thumbnail at the right side 

 
Frame Durat
T
c
longer, while decrea
rate. Values must be between 0.0 and 99.9.  
 
The frame duration is measured in tenths of seconds. For example, if a frame’s duration is set to 
2.2, the frame will hold 2.2 seconds before g
 
�Note: A separate number can be set for each frame in a message. When frames are added or 
copied, the hold time for each new frame behaves as follows: 
 

�� When added, the new frame’s duration takes the default from the Editor defaults box 
(refer to Section 5.14). 

�� Due to the mechanical nature of the Glow Cube displays (the cubes actually flip over),
frame duration for their 
may result in irreparable damage. 

rame 
T
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o invert the colors of a frame (red pixels turn green while green pixels turn red, etc. depending 
n display color), from the Frame pull-down menu, select Invert. Note: This feature does not 

es. 

5.5

Invert Frame 
T
o
apply to text fram
 
 
 Text Frames 

 
The method for entering text onto a text frame is the same for all display types. Position the cursor at 

me and begin to type. Press <ENTER> to move to the following line. The 
urrently selected font, justification setting, flash (or no flash) effect and color are carried to the next 

electing a Font & Entering Text 
Select the desired font using the font name box. The font names 
correspond to their pixel height and line thickness. “Fixed Width” 

perature fields. “Graphic” 

 
e thickness is one pixel. 

1. Enter all of the text on the frame using the default font (“Normal 7”). 
ires a font change, and then click on the down arrow in the font 

name box. 
ont height. 

 
CAUTIO g large fonts for a line of text can “bump” following lines off the display. Text 
on t e

Tri-color and RGB (red-green-blue) displays have the ability to use more than one color to 
relay information. Colors can be applied to the entire frame, a single row, or to individual 

f the display type is monochrome, the color buttons will not appear.  

left sid
 
To add

the desired location on the fra
c
line. 
 
 

S

fonts are ideal for use with time and tem
indicates a graphic character font. Available fonts will vary with 
display type and size. 
 
Example: “Normal 7” is seven pixels high, a typical character is 4
pixels wide and the lin
 
To use more than one font height: 
 

2. Highlight the text that requ

3. Select the desired font. The text line will automatically adjust for the f

N: Selectin
hes  “bumped” lines will automatically be removed from the frame. 

 
 

Color 

 
letters. I
 
To select color other than the default, click on the box containing the desired color at the 
e of the screen. The “A” above the color boxes reflects the chosen color.  

 colored text to the frame, either click on the desired color and then immediately begin 
typing, or highlight existing text and then click on the new color. 
 
 

 



Specifying the Entry Effect 
For text frames, eight entry effects are available: Instant, Scroll Left, Scroll 
Right, Scroll Up, Scroll Down, Roll Up, Roll Down, Roll Left and Travel. 
To set an entry effect, place the cursor on the desired line and then choose 
the desired effect from the drop down window. 
 
 
Line Justification 

Lines of text can be centered, left justified or right justified. To justify a 
line, place the cursor anywhere on the desired line and then click on the 
justification button. 

  
 
 
Flashing Text 

Text can be set to flash by highlighting the desired text and then clicking on the flash button.  
Selected text will appear on a gray background. To turn off the flash, highlight the text and click 
on the flash button again. The rate of flash is set in the Frame Properties dialog box (refer to 
Section 5.8). 

 
 
5.6 Character Map 
 
The character map allows Extended ASCII characters and graphic font 
characters to be inserted into a message without knowing the keystrokes. 
 

1. To access this feature go to the Text pull down menu and select 
Character Map. A character map window will appear.  

2. Make sure that the size of the character on the character map 
matches the size that you want displayed in the message. 

3. Place your cursor in the place that you want the character entered 
and then click on the desired character 

 
 
5.7 Graphic Frames 
 
Only matrix display types, Galaxy, SunSpot and Glow Cube, can use graphic frames. Add a graphic 

frame to your message by clicking on the new graphic frame button , or selecting Insert and then 
Graphic from the Frame pull-down menu. The graphic toolbar should now be active.  
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Graphic Toolbar 

You may notice that a grid is visible on the graphic frame. 
Each box represents a pixel on the display. The pixel 
dimensions of the frame must match the matrix size of the 
display. 
 
 
Creating a Graphic 
Initially the graphic frame will be blank. To create an image, 
click on the desired tool on the graphic toolbar, and then use 
the mouse to draw inside the frame. The primary mouse 
button will use the foreground color. Clicking with the 
secondary mouse button will use the background color. 
 
 
 
 

 
Inserting a Graphic from Another Program 
The Venus 1500 Message Studio allows you to add a logo or graphic from another software 
source (such as MS-Paint� or the Internet).  
 

1. Select the graphic and click on Copy in the host program (i.e. MS-Paint).  
2. Return to the Venus 1500 Message Studio. Be sure the current frame is a graphic frame. 

3. Click on  or select Paste from the Edit pull-down menu. The Message studio 
automatically sizes the graphic to fit the display and inserts it in the graphic frame if the 
automatic resize option is selected in Preferences under the File menu. You can select the 
entire graphic window by double-clicking on it. At this point, you may either copy or cut 
the image or move it with the arrows keys. You can paste into another graphic frame after 
copying or cutting. 

 
 
Importing a Graphic 
This feature in Venus 1500 Message Studio allows you to add other Venus 1500 logos or graphics 
that are saved on an outside source such as a floppy disk by allowing you to navigate to that file 
rather then using the cut and paste method described previously. 

1. Click on the [File] drop down menu and select Import. 
2. From the Import menu select graphic. 

Note: A matrix display must be selected for editing and a graphic frame inserted for this 
option to be enabled. 

3. Navigate to the appropriate file location and complete the importing process. For the best 
results the image to be imported should be the same pixel dimensions as the display. 

 
 

Importing Animation Kits 
This feature in Venus 1500 Message Studio allows you to import animations from the Venus 1500 
CD. 

1. Click on the [File] drop down menu and select Import. 
2. From the Import menu select Animation. You will be prompted to insert the Venus 1500 

installation CD if it is not in the drive. Cancel the Autorun for the Venus 1500 
installations if it starts. 

3. When prompted with a dialog box select the display type that the images will be imported 
for. Click Ok. 

4. A progress monitor will appear while the files are being copied. 
The Venus 1500 Message Studio 
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5. Once the progress monitor disappears the import is complete. 
Adding Text-Objects 
To place text on a graphic frame:  
 

1. Select the Text button from the graphic toolbar 
and then click on the frame. A text-object box 
appears. 

 
Entering Text on a Graphic Frame 

2. Enter the desired text, and then click on  to 
close the text-object box. The text should now be 
visible in the frame. Note: Text overlaid on a 
background image will not be copied if inside of a 
“select” box. Think of the text as a second “layer” 
that is not combined with the background until it 
is sent to the display. 

3. Click and drag the text to the desired location in the frame. You can also use the arrow 
keys to move pixel by pixel.  

4. Click on the desired color for the text (if other than the 
default).  

 
This is also the time to choose a different font. Select the desired 
font type and size from the drop-down menus. Displayed fonts 
are those installed for use by the operating system. You may 
also set justification (left, center or right) for multi-line text.  
 
Note: In graphic frames, the font size may not directly correlate with the height of the font in 
pixels. This is due to the difference between point sizes and actual pixels. 
 
 
Specifying the Entry Effect 
For graphic frames, eleven entry effects are available: Instant, Scroll 
Left, Scroll Right, Scroll Up, Scroll Down, Roll Up, Roll Down, Roll 
Left, Roll Right, Wipe Left and Wipe Right. Select the desired effect 
from the drop-down menu. 
 

 
5.8 Frame Properties 
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Frame properties enables the operator to 
choose the speed at which the chosen entry 
effects occur, set up line by line entry 
effects, set an entry effect for graphic 
frames and set the frame’s duration.  
 
From the Frame pull-down menu, select 
Properties or press <CTRL><ALT><P>. 
The Frame Properties dialog box appears. 
 
The top portion of the dialog box applies to 
text frames. The lower left applies to 
graphic frames. The appropriate area will be active depending on the type of frame selected. 
 
To change the entry effect for a line of text, click once on the entry effect of the line you wish to 
change. Click on it a second time to activate a drop-down menu. Select the new entry effect. 
 

 



The Effect Rate is the speed at which the frame entry effects occur. The Flash Rate is the speed at 
which flashing text will flash. Set either of these rates using the drop-down menu next to the field. The 
default speed is “Normal.” Note: This does not apply to graphic frames. 
 
Eleven entry effects are available for graphic frames: Instant (default), Scroll Left, Scroll Right, Scroll 
Up, Scroll Down, Roll UP, Roll Down, Roll Left, Roll Right, Wipe Left and Wipe Right. When this 
field is enabled, choose the desired effect. 
 
The Duration is set just as described in Section 5.4. 
 
When the settings are complete, click on [CLOSE] to exit the Frame Properties dialog box. 
 
 
5.9 Preview 
 

The preview option previews the entire message, or the 
current frame, as it will appear on the display.  
 
The message or frame will begin to preview as soon as 
the appropriate button is activated. 
 
Pause the message by clicking on the pause button. 

 
 

Printing In Message Studio 
To print the frames from the message studio: 

1. Click on the File pull down menu and select Print. A print pop-up window will appear. 
2. Click on [OK] and the frames will be printed in the order that they will appear on the 

display 
 

 
5.10 View 
 

Use the zoom tool to get a better idea of how a frame or message will appear 
from a distance. Click on the Zoom Out button to reduce the scale of the 
editing area. Use the Zoom In button to increase the scale. Zoom In and 
Zoom Out can also be selected from the View pull-down menu. 

 
 
5.11 Drag and Drop 
 
This allows the frames of a message to be rearranged in the thumbnail viewer.  
 
To rearrange frames: 

1. Click on the frame to be moved. 
2. While holding down the button on the mouse drag the frame to the new location within 

the message. The new location will be shown by a line across the thumbnail viewer. 
3. Release the button on the mouse. The frame has now been moved. 

Note: The thumbnail viewer is capable of being resized based on the size of the display. 
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5.12 Date, Time & Temperature Data Fields 
 
You can insert data fields into a message to display the date, time, temperature (if a temperature 
sensor is present), or other real time data (RTD). The data fields hold a place in the message for 
displaying the desired data. Data fields can be placed only in text frames. Select the desired data field 
from the Data Fields pull-down menu.  
 
The field will appear enclosed in a yellow rectangle. The text can be manipulated as regular text 
(effect, color, flashing and justification). Any attributes chosen will affect the entire field and cannot 
be applied on a character-by-character basis. 
 
Notes:  

�� Some displays do not have enough pixels to accommodate all of the date, time or temperature 
field options. 

The Venus 1500 Message Studio 5-10

 

 
Temperature 

 
Date 

 
Time 

 
5.13 Real Time Data (RTD) 
 
RTD fields allow information 
from an outside source (such as 
a timer or counter) to be inserted 
into the message.  
 
To insert an RTD field: 
 

1. Position the cursor at the 
desired location in the 
Message Studio. 

2. Select RTD from the 
Data Fields pull-down 
menu. The Real Time 
Data dialog box appears. 

 
Once the desired ITF file or field 
type and parameters are chosen, 
click on [OK] or press <ENTER> 
to exit the Real-Time Data 
dialog box and add the field to 
the frame. [APPLY] adds the 
field to the frame, but keeps the Real-Time Data dialog box open so you can continue adding fields. 
[CANCEL] will close the Real-Time Data dialog box without adding the RTD field. 

 
Real-Time Data Dialog Box 

 
 

 



ITF Files 
The top half of the dialog box is reserved for ITF files. ITF files consist of multiple RTD fields 
usually generated by the source program (such as the Venus Market Monitor) to simplify the 
creation of data frames.  
 
To select an ITF file, either click on the down arrow at the top of the dialog box and select the 

desired file from the corresponding list, or click on  and browse to the desired file’s location. 
Once selected, the data from the ITF file will be placed in the Real-Time Data dialog box. 
 
To insert individual fields from the ITF file into the Message Studio:  
 

1. Highlight the desired field number. The associated parameters for that field appear in the 
Parameters box at the bottom of the dialog box. 

2. Click on either [OK] or [APPLY] to add the field. 
 
 

RTD Field Types 
If you choose not to use an ITF file and intend to setup the RTD fields individually, there are three 
field types to choose from: RTD, Extended RTD and Horn RTD.  

 
 

RTD 
RTD fields allow information from an outside source (such as a timer or counter) to be 
inserted into the message. 

 
�� Item Number: The item number is the location in the display’s RTD buffer where the 

information to be displayed will begin.  
�� Length: The length is the number of characters to show in the display’s RTD buffer, 

starting from the item number. The length may be a number between 1 and 50. 
�� Sample Text: Shows the number of characters that will be used for RTD in the 

message based off the length. This text can be modified to “name” the field. 
 
 
Extended RTD 
Note: Extended RTD fields are used for custom applications. Refer to the Venus 1500 
Software Developers Kit for details. 
 
Extended RTD fields are used for changing RTD fields’ font, color and flashing parameters 
without the need to edit and resend the existing message. The fields are updated in the same 
manner as the RTD information being displayed. 
 
CAUTION: Extended RTD utilizes the four bytes prior to the displayed RTD information to 
store attribute information. Caution must be taken to avoid overwriting this information. 
 

�� Item Number: The item number is the location in the display’s RTD buffer where the 
information to be displayed will begin.  

�� Length: The length is the number of characters to show in the display’s RTD buffer, 
starting from the item number. The length may be a number between 1 and 50. 

�� Sample Text: Shows the number of characters that will be used for RTD in the 
message based off the length. This text can be modified to “name” the field. 
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Horn RTD Field 
The Horn RTD field controls the display’s horn, if one is installed. It is displayed for use 
with sporting applications, receiving RTD feeds from some external Daktronics sports 
controllers. This field appears as Hs in the Message Studio, but when the message runs, 
nothing is visually displayed. Due to this action, it is recommended to place the horn field at 
the end of a line in a message. 
 

�� Item Number: The item number is the location in the display’s RTD buffer where the 
information to be displayed will begin.  

�� Length: Disabled 
�� Sample Text: “H” 

 
 
5.14 Changing the Editor Defaults 
 
The Editor Defaults define the default settings in the Message Studio. The Editor Defaults dialog box 
is divided into two areas, General and Type Specific.  
 
Default settings listed under General apply to all display types. Those settings listed under Type 
Specific apply only to the type of display listed in the Display Type box. 
 
To edit these defaults, go to the File pull-down menu and then select Preferences. The Editor Defaults 
dialog box appears. 

 
1. Choose the desired default options by 

clicking on the down arrow next to the 
appropriate fields, and then highlighting the 
selection. 

2. When checking Bitmap Auto-Scaling, 
images that are placed in a frame are 
automatically re-sized to fit the sign. If this is 
not selected, the image is placed on the sign 
according to its original size. 

3. When it’s finished, click on [OK] or press 
<ENTER> to save the changes and return to 
the Message Studio. [APPLY] will save the 
settings but the Editor Defaults dialog box 
will remain open. 

 
[CANCEL] will leave the Editor Defaults as they are 
and return to the Message Studio. 
 

 
Changes to the settings will only be applied to new messages and frames added after the defaults have 
been altered. 
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5.15 Adding a Description 
 
The operator can add a description to a message to better explain or define what the message consists 
of or shows. 
  
From the File pull-down menu, select Set Message Description. A dialog box appears. Enter a short 
description for the message. Click on [OK] to apply the description or [CANCEL] to cancel and close 
the dialog box. After the message is saved, the message description will appear next to the message’s 
file name in the Open Message dialog box (refer to Section 5.1). 

 
 
5.16 Saving & Renaming the Message 
 
�Note: You cannot save messages for one display type within the directory of another display type. 
 
 

New Message 
Before you can save a new message, you must give it a name and determine the library (folder) it 
should be saved within.  
 

1. From the File pull-down menu, select Save or Save As. A dialog box similar to that 
shown in Section 5.1 appears. 

2. Select the name of the library (folder) under which the message should be saved, or create 

a new library by clicking on the Create Folder button , and then entering a name for 
the new library. 

3. With the name of the preferred library highlighted, enter the name for the new message in 
the File Name field. Up to eight characters may be used. 

4. Click on [SAVE]. 
 
 

Existing Message 
Saving an existing message is even easier. From the File 
pull-down menu, select Save, or click on the Save button 

.  
 
If you try to close a message before saving, a pop up window appears asking you to save changes.  

 
 

Renaming a Message or Saving to Another Location 
Follow the steps listed for saving a new message to rename a message or save it to another 
location. The previous name will still exist at the current location, and will need to be deleted if it 
is no longer needed. 
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5.17 Deleting a Message 
 
To remove a message from the Message Studio: 
 

1. From the File pull-down menu, select either Open or Save As. A dialog box similar to that 
shown in Section 5.1 appears. 

2. Highlight the name of the message to delete. 

3. Click on the delete button . A verification dialog 
box appears. 

4. Select [YES] to delete the message. [NO] to cancel 
this command. 

 
The message will be removed from the library. 
 
 
5.18 Exiting from the Venus 1500 Message Studio 
 
To close the Venus 1500 Message Studio, select Exit from the File pull-down menu. If any messages 
have not been saved, a dialog box appears. Click on [YES] to save the message, [NO] to exit without 
saving, or [CANCEL] to stop the exit command.  
 
Upon exiting the Message Studio, you are returned to the Venus 1500 Shell. 
 
 
5.19 Venus 1500 Message Studio Keyboard Shortcuts  
 

Command Shortcut Keys 
Add New Graphic Frame <CTRL><W> 
Add New Text Frame <CTRL><A> 
Insert a Copy of the Frame <CTRL><INSERT> 
Delete Frame <CTRL><DELETE>
Previous Frame <F11> 
Next Frame <F12> 
Frame Properties <CTRL><ALT><P>
Clear Frame <CTRL><Q> 
Selector (Graphic Tools) Keypad </> 
Pencil (Graphic Tools) Keypad <+> 
Fill (Graphic Tools) <CTRL><F> 
Text (Graphic Tools) <CTRL><T> 
Line (Graphic Tools) <CTRL><L> 
Rectangle (Graphic Tools) <CTRL><R> 
Rounded Rectangle (Graphic Tools) <CTRL><D> 
Ellipse (Graphic Tools) <CTRL><E> 
New Message <CTRL><N> 
Open Message <CTRL><O> 
Save <CTRL><S> 
Cut <CTRL><X> 
Copy <CTRL><C> 
Paste <CTRL><V> 
Preview <F5> 
Preview Frame <F6> 
Stop Frame <ESC> 
Close Message Studio <ALT><F4> 
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Section 6: The Venus 1500 Schedule Studio 
 
 
The Venus 1500 Schedule Studio is used to configure schedules for the display(s). Messages and 
display brightness can be set on a day-to-day, hour-to hour and minute-to-minute basis. Up to 40 
entries can be inserted into a schedule. Schedules for more than one type of display can be open for 
editing at one time.  

Click on  from the Venus 1500 Shell to activate the Schedule Studio.  
 

 

 
Venus 1500 Schedule Studio 

 
A toolbar, located below the pull-down menu at the top of the Schedule Studio, can be used to 
simplify some commands. Note: Some buttons may not be active unless an entire line or group of 
lines are selected. The buttons are listed below.  

�� To select a line, click on its number (1 through 40) at the left side of the screen.  
�� To select a range of lines, press and hold <SHIFT> while using the mouse to click on the first 

and last lines of the range.  
�� To choose several non-consecutive lines, press and hold <CTRL> while clicking on the desired 

lines.  
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6.1 Starting a New Schedule 
 
To start a new schedule: 

1. Select New from the File pull-down menu or click on . The 
New Schedule dialog box appears.  

2. Double-click on the type of display for the new schedule, or 
highlight the display type and click on [OK]. 

 
A new, blank schedule is opened in the Schedule Studio. 
 
 
 
 
 
 
 
 
 
 
6.2 Opening an Existing Schedule 
 
To open an existing schedule for editing or viewing: 

1. From the File pull-down menu, select Open, or click on . The Open Schedule dialog box 
appears.  

2. Select the display type and library containing the schedule. 
3. Highlight the schedule name and click on [OPEN]. 
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6.3 Using the Schedule Studio 
 
When creating or editing a schedule, there are a few things to keep in mind.  
 

�� Messages scheduled to run during the same time frame will appear in the order they are listed 
in the schedule.  

�� The schedule is limited to 40 entries. This includes both messages and brightness commands. 
�� When setting Start and Stop times and dates, the start time/date must be earlier in the day than 

the stop time/date. If the start time/date is greater than the stop time/date, the event will never 
begin. 

�� The year is not adjustable. The software will automatically advance to the next year at the 
appropriate time. 

 
 

Choosing the Type of Event 
To choose which message to display or to set the display brightness, double-
click on “NONE” in the desired line. Select “MESSAGE” to schedule a 
message, or “BRIGHTNESS” to set display brightness. 
 
 

Message 
Once “MESSAGE” is selected, click once in the Event box in the same row. The 
box will turn black and a small button at the right side appears. Click on the button. 

This activates the Open Message dialog box. Highlight the library and then the preferred 
message. 
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Brightness 
“BRIGHTNESS” can be set to either auto or manual. Auto will adjust the 
brightness of the display’s LEDs or lamps based off readings from an installed 
light sensor. Manual is used to set a specific value for the brightness of the display 

at a particular time. Possible values range between 0 (complete dimming) and 63 (full 
brightness). 

 

 
 

Setting the Start Time/Stop Time 
Each event will begin running at the Start Time where the day of the 
week is checked beginning on the First Date. Each event will stop 
running at the Stop Time where the day of the week is checked 
ending with the Last Date. 
 
Highlight the digit to be changed and either enter the desired number 
using the keyboard or click on the up and down arrows.  
 
The Start Time is the first minute of the selected day when the event will run. The Stop Time is 
the last minute of the day when the event will run. The event will run until the end of the minute 
(i.e. a Stop Time of 11:59 will actually stop running at 11:59:59). 
 
For example, to run a message for one minute at 12:00 noon, both the Start Time and the Stop 
Time will be 12:00 PM. 
 
�Note: The Start Time for an event must be earlier in the day than the Stop Time. If the Start 
Time is greater than the Off Time, the event will never start.  
 

 



For example, if a message is to run from 11:00 PM to 1:00 AM, two events need to be entered. 
Event 1 would run from 11:00 PM (Start Time) to 11:59 PM (Stop Time) and Event 2 would run 
from 12:00 AM (Start Time) to 1:00 AM (Stop Time). 
 
 
Setting the First Date/Last Date 
Events may be set to activate only during a specific range of dates. 
Highlight the digit to be changed and either enter the desired number 
using the keyboard or click on the up and down arrows. The day and 
month will increment/decrement accordingly.  
 
The First Date is the first day of the year when the event will run. The 
Last Date is the last day of the year when the event will run. 
 
�Note: The date is like the time in that it does not wrap around. The First Date must be earlier 
in the year than the Last Date or the event will not run. 
 

Special Note: The year is not adjustable. The software will automatically change to the next year 
at the appropriate time. For example, if a message is to be displayed for the New Year right after 
midnight of December 31, set the First Date as January 1. The computer will automatically 
change to the next year and display the message.  
 
For example, to run a message on both December 31 and January 1, Event 1 would have a first 
and last date of 1/1 and Event 2 will have a first and last start date of 12/31. 
 
 
Setting the Days of the Week 
A blackened box under a day of the week indicates that the 
event will run on that day. This option allows individual 
days of the week to be selected without creating multiple 
entries with Start/Stop times and dates in the schedule. 
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By default, all days are selected. To deselect a particular day, 
click on the box underneath it. (This box is a toggle. Click on it again to select the day.) In the 
third line, above, the event will run only on Mondays during the specified first and last dates. All 
other entries shown will run every day of the week. 
 
 

Adding a Description 
At any time you can enter a description of the schedule. This description 
does not change if the events change. The schedule description will be 
visible in the Open Schedule dialog box. 

 
 

 

 



6.4 Naming & Saving the Schedule 
 
To name (or rename) the schedule, click on the File pull-down menu and select Save As. The Save 
Schedule dialog box appears. Select the library in which the schedule should be stored. Enter the 
schedule name in the File Name box. Up to eight characters may be used. Spaces are not permitted. 
Click on [SAVE]. 
 

To quickly save a schedule during editing, click on , or select Save from the File pull-down menu.  
 
Daktronics recommends saving at regular intervals to prevent accidental loss of information. 
 
 
6.5 Printing 
 
The completed schedule can be printed to obtain a paper copy of the file. Information that will be 
included are the schedule’s name and description, the technology and size of the display for which the 
schedule was created, the total number of entries (messages) in the schedule, and a listing of each 
event that will run and when.  
 
Use Print Preview (found under the File pull-down menu) to view the information as it will appear 
on the paper copy. 
 

 

 
Print Preview 

To print the schedule, either click on [PRINT…] from the Print Preview screen or select Print from the 
File pull-down menu. Use Print Setup, also found under File, to change printer settings. 
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6.6 Exiting the Venus 1500 Schedule Studio 
 
To exit the Schedule Studio, select Exit from the File pull-down 
menu. If any schedules have not been saved, a dialog box appears. 
Click on [YES] to save the schedule, [NO] to exit without saving, or 
[CANCEL] to stop the exit command.  
 
Upon exiting the Schedule Studio, you are returned to the Venus 
1500 Shell. 
 
 
6.7 Venus 1500 Schedule Studio Keyboard Shortcuts  
 

Command Shortcut Keys
Move Up <CTRL><M> 
Move Down <CTRL><D> 
New Schedule <CTRL><N> 
Open Existing Schedule <CTRL><O> 
Save <CTRL><S> 
Print <CTRL><P> 
Cut <CTRL><X> 
Copy <CTRL><C> 
Paste <CTRL><V> 
Undo <CTRL><Z> 
Exit Schedule Studio <ALT><F4> 

 
 
6.8 Sample Schedule 
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Entry 
No. Type Message 

Name 
Library 
Name The Message will Run… 

1 Message Christms Holidays 24 hours per day, everyday from Dec. 1 through 
Dec. 25 

2 Message Stpat Holidays From 7 AM through 10:01 PM on March 17 

3 Message Special Default From 6 PM through 11:59 PM on Mondays during 
the month of June 

4 Message Spring Default 24 hours per day from March 1 through March 21 

5 Message Valentin Holidays From 6 AM through 10:00 PM, Monday through 
Friday, from Feb. 1 through Feb 14 

6 Message KeepCool Summer 24 hours per day on Fridays, Saturdays and 
Sundays between May 20 and August 31. 

7 Message Picnic Summer 24 hours per day on Saturdays and Sundays 
between June 5 and June 12 

8 Message Waves Summer 24 hours per day on Mondays, Wednesdays and 
Fridays from June 1 until Sept. 3. 

9 Message Ghost Holiday From 7 PM until 11:59 PM, everyday between Oct. 
15 and Oct. 31. 

10 Message Ghost Holiday 

From midnight until 4:59 AM, everyday between 
October 16 and Oct. 31. (Because the end time 
cannot be before the start time, entries 9 and 10 
together ensure the message runs through the 
night.) 

11 Brightness Automatic Dimming is 
Active 

Dimming based off the light sensor will occur 24 
hours per day, all year. 

12 Message Newyear Holiday All day on January 1. 
13 Message Newyear Holiday From 3 PM until 11:59 PM on December 31. 
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Section 7: The Venus 1500 Display Manager 
 
 
The Venus 1500 Display Manager controls communications with the displays, is capable of basic 
display monitoring functions, and has some diagnostic capabilities.  

When the Venus 1500 Display Manager is activated from the Venus 1500 Shell (click on ), 
a screen similar to the one shown below appears. 
 

 

 
Venus 1500 Display Manager – Message Control 

Daktronics displayed the Venus 1500 Display Manager in three parts: Message Control, shown above, 
Schedule Control, and Diagnostic control. Each part is discussed in detail later in this section. 
Regardless of the part you are viewing, the screen is divided into three basic areas: the Display List, 
the status results area (where Available Memory is shown), and the Control Area. 
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Display List 
The Display List shows all the displays configured for the Venus 1500 network. In addition to 
each display’s name, the list graphically illustrates the connection type (direct , modem  or 
TCP/IP ) and the display technology. This may include: 

�� LED Monochrome   
�� LED Tri-Color  
�� LED RGB  
�� Incandescent  
�� Glow Cube� reflective displays  

 
To select the display with which you want to 
communicate (to send messages or schedules, 
retrieve message lists, etc.), click once on the 
name of the display or group of displays in the 
Display List.  

 
Advanced Status 

 
 
Status Results 
Check the status of any display at any time by 
selecting its name from the Display List, and 
then clicking on [GET STATUS] or double-
clicking on the display’s name. The Venus 1500 
software establishes communications with the 
display and shows most often used results in the 
bottom left corner of the application.  
 
Once display status is retrieved from the display, 
view advanced status results by clicking on 

. 
 
The Available Memory gauge at the bottom of the screen shows how much of the display’s 
memory is currently used by messages and schedules stored within the display. 
 
 
Control Area 
The control area of the screen is located to the right of the Display List and status area. Its general 
appearance will change depending on whether you are using Message, Schedule or Diagnostic 
Control. 
 
 

7.1 Message Control 
 

If it is not already selected, click on . The Venus 1500 Display Manager screen adjusts for 
Message Control.  
 
The control area of the screen is divided into two basic halves; the left side shows messages that are 
currently stored within the Venus 1500 controller computer that are available to run on the selected 
display, the right side lists the messages currently running and stored at the display site. The message 
control buttons are between the two areas. These buttons are used to send messages to the display, run 
or stop an individual message, or blank the display.  
 
Select more than one message at the display site by pressing <CTRL> while clicking on the message 
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names with the mouse. Select a range of messages by pressing <SHIFT> while choosing the desired 
messages. 
 
 

Determining what Messages are Running on a Display 
To view the list of messages stored at the display select the desired display from the Display List, 
and then click on [GET STATUS]. The control area of the screen will update with the information 
retrieved from the display. 
 
In the right half of the control area (the display side), the list of messages currently running on the 
display will appear under Running Messages. Messages appear on the display in the order they 
are running unless the display is running a schedule. 
 
Any messages that are not running, but are saved at the display site, will be listed under Stored 
Messages. 
 
 
Sending Messages to a Display 
To send a message from the Venus 1500 controller computer to a display, highlight the name of 
the message under the Available Messages column. Click on . The message will be added to 
the end of the Stored Messages list. 
 
You may also send a message or a schedule to a display by double-clicking on the file in the tree 
file viewer. 
 
Multiple messages may be sent at one time by holding down the shift key and selecting a range to 
be sent. Note: All messages within the range will be selected and sent to the display with this 
method. 
 
 
Running a Message  
There are three ways to run a message on a display. The message is added to the end of the 
Running Messages list. 

 
To run a message already stored at the display site:  

�� Highlight the name of the message under the Stored Messages column, and then click 
on .  

�� Under the Stored Messages column, double-click on the message’s name. 
 

To run a message not yet sent to the display,  
�� Highlight the name of the message in the Available Messages column (left half of the 

control area). Click on . The message is automatically sent to the display site and 
begins to play. 

 
 
Stopping a Message from Running on a Display 
When you stop a message, it will immediately stop running on the display and its name will be 
moved to the Stored Messages list. Either: 

�� Highlight the message name under the Running Messages column and then click on .  
�� Under the Running Messages column, double-click on the message’s name. 
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Blanking the Display 
To stop all messages running on the display, click on . The display will now be completely 
blank. 
 
 
Retrieving a Message from a Display 
 

This feature applies only to the following firmware versions for the various technologies: 
�� InfoNet Displays (excluding model G-1000 Displays): Revision 14 or higher 

(Firmware Number ED-10133) 
�� Venus 1500 Controlled DataTrac Displays: Revision 16 or higher (Firmware 

Number ED-10132) 
�� Galaxy, SunSpot or Glow Cube displays: Revision 17 or higher (Firmware Number 

ED-10134 for Galaxy Displays; ED-12699 for RGB Galaxy Displays) 
 
The Retrieve Message command copies an existing message from the display to the central 
controller computer for editing in the Venus 1500 Message Studio. To retrieve a message: 
 

1. Highlight the desired message under the Stored Messages column in the Venus 1500 
Display Manager. 

2. Click on  to retrieve the message. 
 
�Note 1: Text objects placed on graphic frames are merged into a single image once the message 
is sent to a display. Therefore when a message containing such a frame is retrieved, the graphic 
frame can only be edited on a pixel by pixel basis. The text object is not longer separately 
available for editing in text mode. 
 Note 2: The Advanced Status button will list the current firmware version used by the display. 
 
 
Deleting a Message from a Display 
To remove a message stored at the display site and free memory, select the name of the message 

from the Stored Messages or Running Messages column and then click on . 
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7.2 Schedule Control 
 

Click on . The 
Venus 1500 Display 
Manager screen adjusts 
for Schedule Control.  

 
Venus 1500 Display Manager – Schedule Control 

 
As with Message Control, 
the control area of the 
screen is divided into two 
basic halves; the left side 
shows schedules that are 
currently stored within the 
Venus 1500 computer, the 
right side lists the current 
schedule stored at the 
display site, if any. 
Between the two areas are 
the schedule control 
buttons. These buttons are 
used to send, stop or run a 
schedule on the display. 

 
Viewing the Available Schedule & Determining if a Schedule is Running on the 
Display 
To view the available schedules for a particular display, select the appropriate display name from 
the Display List, and then click on [GET STATUS]. The control area of the screen will update with 
the information retrieved from the display. 
 
If a schedule is present at the display, its name will appear as the Current Schedule in the right 
half of the control area (the display side). A status of “ACTIVE” indicates the schedule is running. 
An “INACTIVE” schedule is not currently running on the display. 
 
 
Sending a Schedule to the Display 
To send a schedule from the Venus 1500 controller computer to a display, highlight the name of 
the schedule under the Available Schedules column. Click on . If any messages listed on the 
schedule are not stored at the display, they are automatically sent also. 
 
 
Running a Schedule 
To run a schedule that is stored at the display site, click on . The schedule will begin running. 
 
 
Stopping an Active Schedule  
To stop a schedule, click on . The schedule’s status will change to “INACTIVE.”  
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7.3 Diagnostic Control 
 

Click on . The 
Venus 1500 Display 
Manager screen adjusts 
for Diagnostic Control.  
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Diagnostic control is used 
to set the display’s 
time/date, brightness level, 
pixel test, temperature 
offset and to reset the 
display. 
 
 

Set Time/Date 
Click on [SET 
TIME/DATE] to update 
the time and date on 
the selected display’s 
internal clock to match 
that of the computer 
running the Venus 1500 software. 

 
Venus 1500 Display Manager – Diagnostics Control 

 
 
Set Brightness 
Set Brightness has three options: 
 

�� Automatic – The display’s brightness level adjusts automatically based off readings from 
an external light sensor at the display’s site, when present. This is the recommended 
setting. 

�� Manual – This option permits the operator to adjust the intensity of the display using the 
Min/Max slider bar at the right. 

�� Schedule – When a schedule is running, the display’s brightness adjusts as programmed 
in the schedule. 

 
Select the desired option and then click on [SET BRIGHTNESS] to activate it for the selected 
display. 

 
Pixel Test Options 

 
 
Pixel Test 
The pixel tests are used to assist maintenance personnel who may be 
troubleshooting the display.  
 
The pixel test is available only for the following firmware versions. Your 
Venus 1500 display will display its firmware version upon power up or 
reset. Refer to its maintenance and troubleshooting manual. 

 



 

�� InfoNet Displays (excluding model G-1000 Displays): Revision 14 or higher 
(Firmware Number ED-10133) 

�� Venus 1500 Controlled DataTrac Displays: Revision 16 or higher (Firmware 
Number ED-10132) 

�� Galaxy, SunSpot or Glow Cube displays: Revision 17 or higher (Firmware Number 
ED-10134 for Galaxy Displays; ED-12699 for RGB Galaxy Displays) 

 
Select the desired test from the drop down menu. “Cycle All” will run all of the listed tests. Click 
on [START TEST]. Once testing is complete, click on [STOP TEST]. 
 
�Note: Not all listed tests will work with every display. If a particular test does not appear on 
your display, then that test is not supported in the display’s firmware. 
 
 
Temperature Offset 
The temperature offset is used when the external temperature sensor at the display site needs to be 
adjusted to reflect the true outside temperature. The offset increases or decreases the measured 
temperature by the specified amount before showing it on the display.  
 
Use the up and down arrows to specify the amount of offset. The temperature can be adjusted by 
plus or minus 9 degrees Fahrenheit. Click on [SET TEMPERATURE OFFSET] to activate the 
adjustment. 
 
 
Reset Display 
[RESET DISPLAY] restarts the controller inside the selected display. Refer to the display’s 
maintenance and troubleshooting manual for the list of boot up initialization information that will 
appear on the display upon reset. 
 
To remove all messages and schedules saved at the display site, check the box next to Clear 
Display Memory, and then click on [RESET DISPLAY]. A confirmation dialog box appears. Select 
[YES] to continue the reset command.  
 
The Available Memory for the display should be “empty” the next time you retrieve the display’s 
status. The display time and date will default to midnight on 01/01/95. 
 

CAUTION: Resetting the display will temporarily interrupt operation and is typically used only 
during troubleshooting. 
 
 

7.4 About the Display Manager 
 
Click on the Venus 1500 drop-down menu and select About.  
 
The dialog box lists Daktronics contact information and customer service phone numbers. 
 
Click on [OK] to close the box and return to the Display Manager. 
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7.5 Exiting the Display Manager 
 
To close and exit the Venus 1500 Display Manager, either click on 

 in the upper right corner of the screen, or select Exit from the 
Display Manager drop-down menu (shown at right). 

 
Display Manager Drop-
Down Menu 

 
You are returned to the Shell program. 
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Appendix A: System Riser Diagram 
 
 
 

Appendix A: System Riser Diagram A-1
 









Appendix B: Graphics & Special Characters 
 
 
The following table lists special characters that may be used when creating text by holding down on 
<ALT> and then typing the following three numbers in sequence. For example, to get the character 
“Ç,” press <ALT> <1> <2> <8>. 
 

Character Code 
Ç <ALT> <1> <2> <8>
ü <ALT> <1> <2> <9>
é <ALT> <1> <3> <0>
â <ALT> <1> <3> <1>
ä <ALT> <1> <3> <2>
à <ALT> <1> <3> <3>
å <ALT> <1> <3> <4>
ç <ALT> <1> <3> <5>
ê <ALT> <1> <3> <6>
ë <ALT> <1> <3> <7>
è <ALT> <1> <3> <8>
ï <ALT> <1> <3> <9>
î <ALT> <1> <4> <0>
ì <ALT> <1> <4> <1>
Ä <ALT> <1> <4> <2>
Å <ALT> <1> <4> <3>
É <ALT> <1> <4> <4>
æ <ALT> <1> <4> <5>
Æ <ALT> <1> <4> <6>
ô <ALT> <1> <4> <7>
ö <ALT> <1> <4> <8>
ò <ALT> <1> <4> <9>
û <ALT> <1> <5> <0>
ù <ALT> <1> <5> <1>
ÿ <ALT> <1> <5> <2>
Ö <ALT> <1> <5> <3>
Ü <ALT> <1> <5> <4>
¢ <ALT> <1> <5> <5>
£ <ALT> <1> <5> <6>
¥ <ALT> <1> <5> <7>
₧ <ALT> <1> <5> <8>
ƒ <ALT> <1> <5> <9>
á <ALT> <1> <6> <0>
í <ALT> <1> <6> <1>
ó <ALT> <1> <6> <2>
ú <ALT> <1> <6> <3>
ñ <ALT> <1> <6> <4>
Ñ <ALT> <1> <6> <5>
ª <ALT> <1> <6> <6>
º <ALT> <1> <6> <7>
¿ <ALT> <1> <6> <8>
½ <ALT> <1> <7> <1>
¼ <ALT> <1> <7> <2>
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¡ <ALT> <1> <7> <3>
█ <ALT> <2> <1> <9>
� <ALT> <2> <4> <0>
� <ALT> <2> <4> <1>
� <ALT> <2> <4> <2>
� <ALT> <2> <4> <3>
� <ALT> <2> <4> <4>
� <ALT> <2> <4> <5>
� <ALT> <2> <4> <6>
� <ALT> <2> <4> <7>
° <ALT> <2> <4> <8>
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B=Up Left Arrow C=Down Left Arrow D=Down Right Arrow E=Up  ArrowA=Up Right Arrow

F=Down Arrow G=Left Arrow H=Right Arrow I=Burst 1 J=Burst 2

K=Jack-O-Lantern L=Present M=Umbrella N=Ghost O=Sun

P=Sled Q=Bell R=Rocket S=Valentine T=Birthday Cake

U=Reindeer V=Prancing Reindeer W=Large Butterfly X=Small Butterfly Y=Fish

Z=Sleeping Owl a=Motorcycle b=US Flag c=Football d=Football Goal

e=Gun f=Sailboat g=Guitar h=Horn i=Notes

j=Eye Looking Right k=Eye Looking Left l=Foot m=Tapping Foot n=Ear

o=Wrench p=Goblet q=Car Key r=Suitcase s=Clock

t=Plug u=Hammer v=Speaker w=Camera x=Telephone

y=Television z=Handicap Symbol 1=Big Heart 2=Small Heart 3=Club
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‚
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/=Jet ?=Small Ball
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The Venus 1500 Controller is capable of displaying various non-English fonts using graphic frames 
(not text frames) in the Venus 1500 Message Studio.  
 
 
C.1 Compatible Languages 
 
During testing1, Daktronics found that some languages worked very well with the Venus 1500 
software, while others did not. The information provided below indicates which languages are 
compatible with the Venus 1500 software, which languages may be used but are not supported by 
Daktronics technical staff, and which languages are not supported.2 3  
 
The following languages work in the Venus 1500 graphic frames: 
 

Arabic Dutch French 
German Hebrew Indonesian 
Italian Malay Portuguese 
Spanish Thai  

 
The following languages require installing third party fonts from the Internet. It is possible to use them 
in the Venus 1500 Controller software, but they are not supported by Daktronics technical staff: 
 

Greek 
Hindi 
Russian 
Tamil 

 
The following languages do not work in the Venus 1500 Controller software, and are not supported by 
Daktronics technical staff: 
 

Chinese 
Japanese 
Korean 
Vietnamese 

 
 
C.2 Initial Settings 
 
�Note: You may need to use the Windows� 2000 or NT CD-ROM while specifying the initial 
settings. 
 

1. Click  on the Windows desktop.  
2. Choose Settings and then Control Panel. 

                                                      
1 Languages were tested using the English version of Windows 2000. Windows NT should work also. 
2 Daktronics, Inc. does not support operating systems for non-English languages. 
3 Some characters may also require a language-specific keyboard to be accessible. 
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3. Double-click on Regional Options (Windows 2000) or Regional Settings (Windows NT). 
 
 

Windows 2000 
1. At the bottom of the General tab is a section called Language settings for the system. 

Select the desired language and click on [APPLY].  
2. Select the Input Locales tab. “English” may be the only language listed in the Input 

language box.  
3. Click on [ADD…].  
4. From the Input locale list, select the non-English language and appropriate country. The 

Keyboard layout/IME option will be selected accordingly.  
5. Click on [APPLY] to save the new settings, and then [OK] to exit the control panel. You 

may need to reboot the system once you have done this. 
 

A blue icon will appear on the right side of the 
Taskbar (next to the clock). The “EN” indicates 
that the current input locale is English. 

 
 

Windows NT 
1. At the Regional Settings tab, 

select the desired language and 
then click on [APPLY].  

2. Select the Input Locales tab. 
“English” and the recently 
selected language should both 
be listed in the Input locales 
box.  

3. To change the keyboard layout, 
click on [ADD…].  

4. Choose the appropriate 
keyboard for the non-English 
language and click on [OK].  

5. Check the checkbox next to 
Enable indicator on taskbar.  

6. Click on [APPLY] to save the 
new settings, and then [OK] to 
exit the control panel. You may 
need to reboot the system once 
you have done this. 

 
A blue icon will appear on the right side of the Taskbar (next to the clock). The “EN” indicates 
that the current input locale is English. 
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C.3 Displaying the Font 
 
To create a graphic frame with the non-English fonts:  
 

1. Create a new graphic frame in the Venus 1500 Message Studio (refer to Section 5.7).  
2. Select the Text button from the 

graphic toolbar and then click on the 
frame. A text-object box appears.  

3. To display a non-English font, click on 
the blue “EN” icon on the taskbar, and 
then select the desired font. 

4. Select the appropriate font in the Venus 1500 Message Studio (e.g. Simplified Arabic) and 
font size.  

5. Enter the desired text.  
 
�Note: When you wish to save the message, you will need to switch the input locale back to English 
using the blue icon on the taskbar. 
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